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® Introduction
» Grand Challenge
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Hoare and Misra proposed [HMO05]
« Grand Challenge for research in computing science

« Verified Software Repository (http://vsr.sourceforge.net)

Goals
» Apply formal methods to real problems

» Automation of verification processes

» Focus on tool interoperability


http://vsr.sourceforge.net
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« Electronic purse protocol
o Great community response

e Practical results in model based verification

POSIX File Store
» on going effort to verify a POSIX compliant file system

» wide spread impact on many kinds of devices

¢ increased complexity
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Mini-challenge
» proposed by Joshi and Holzmann (NASA - JPL) [JHO7]

« specific for FLASH hardware

« intended for ( ) Mars Rover system
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® Introduction

* Work at Minho
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BSc course 2006/07

Preliminary work:
» VFS model: POSIX file store (VDM++) [ST07]
+ ONFI model: flash device (VDM++) [DF07]

MSc course 2007/08 [DIU]

Currently working on modeling IFFSC (Intel Flash File System
Core) in
« Alloy

« HOL

 VDM++
Why three different models?
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# |ntroduction

* Intel Flash File System Core (IFFSC)



Introduction
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Intel Flash File System — Architecture

OS File System API

¥
Real-time Operating System
(RTOS) Wrapper Interface

RAM FIFO Buffer File System Layer
Data Objects Layer

Flash File System Core
———————————— —————————
Basic Allocation Layer -« Reclaim Module

0S Resources Translation Layer
0S External Libraries

Flash Interface Layer

v
0OS Specific Layer

L 4
Translation Layer

———————

Low-Level

L2
Flash Hardware

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Advantages

+ POSIX aware

« designed for FLASH memory
« layered architecture

» VFS and ONFI fit in IFFSC

Disadvantages
o document is currently deactivated

» some inconsistencies (eg. data type mismatch)
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® \erification Life Cycle
+ Strategy
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We are using several tools of different kinds at the same time.
Why?
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We are using several tools of different kinds at the same time.
Why?
Consider a typical proof obligation:

Satisfiability
Va-acAApre-Op(a):3b - be BApost-Op(b, a) (1)
that is (in case of deterministic operations):
Va-aecAAnpre-Op(a): Op(a) € B (2)

(a € Aand b € B check for the invariants associated to A and B, respectively)
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Different scenarios:

@ Op satisfies (2) but is semantically wrong — its does not
behave according to the requirements

¢ need for manual tests
o strategy is to run the model as a prototype

Thus the VDMTools
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Different scenarios:
@ Op satisfies (2) but is semantically wrong — its does not
behave according to the requirements

¢ need for manual tests
o strategy is to run the model as a prototype

Thus the VDMTools

@ Op survives all tests (including dynamic type checking)
and yet it does not satisfy (2)

* a model checker able to generate counter-examples to (2)
is useful
o suggestions on how to improve Op are welcome

Thus Alloy

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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@ Model checker doesn’t find any counter examples
« a theorem prover is welcome to mechanically discharge (2)

Thus HOL

manual
Thus the PF-transform
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@ Model checker doesn’t find any counter examples
« a theorem prover is welcome to mechanically discharge (2)

Thus HOL

@ PO (2) is too complex for the available theorem prover

o decompose too complex PO into smaller sub-goals
» the ultimate hope is a pen-and-paper manual proof

Thus the PF-transform
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® \erification Life Cycle

* Process



Verification Life Cycle
O@000000000

Development & Verification Process

Modelling & Animation & Testing

Proof obligation

Counterexample found (
Alloy

Model Checking

Assertion might be valid

Done HOL
Verification

Proof failed

Done PF
Calculation

Try simplified proof

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Problem

Understand the Problem

Abstract Model

VDM
Modelling & Animation & Testing

Proof obligation

Counterexample found

Alloy
Medel Checking

Assertion might be valid

Done HOL
Verification

Proof failed

Dane PE
/ Calculation

Try simplified proof
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Model

| Modeing & Animation & Testing

Proof obligation

Alloy
Model Checking

Counterexample found (

Verification

Proof failed

Calculation

Dune

Try simplified proof

animate prototype
run test suites

run Integrity Checker to generate
POs
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Model Check

Problem

capture data types and invariants

| Modling & Animation & Testing

T capture functions, pre and post
Proof obligation Condltlons

)

Counterexample found

abstract sequences and numbers
TN oone | HoL )

Proof failed

Calculation

Dune

Try simplified proof
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Model Check

Problem

capture data types and invariants

VDM

| Modling & Animation & Testing

T capture functions, pre and post
Proof obligation Condltlons

)

Counterexample found

abstract sequences and numbers
TN oone | HoL )

I assert proof obligations

Dune

try and find counter-examples

Try simplified proof
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Review VDM++ Model

Maualllng & Animation & Testing

Proof obligation

Counterexample found (*
Alloy

Model Checking

Assertion might be valid

Dane

Verification

Proof failed

Dane
Calculation

Try simplified proof

the assertion is invalid

counter-example show why and

how
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Review VDM++ Model

Problem

Abstract Model

VDM
Mauolllng & Animation & Testing

Proof obligation

Counterexample found (*
Alloy

Model Checking

Assertion might be valid

HOL

Verification

Proof failed

Dune

Calculation

Try simplified proof

the assertion is invalid

counter-example show why and
how

error in model?
too weak a pre-condition?
too strong an invariant?
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Attempt Automatic Proof

Problem

assertion of PO may be valid

Modelling & Animation & Testing

gained increased confidence, but no

P@j certainty

Counterexample found (

Alloy
Model Checking

Assertion might be valid
Done
i/ Verification

Proof failed

A Done
J Calculation

Try simplified proof
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Attempt Automatic Proof

Problem

assertion of PO may be valid

gained increased confidence, but no
Modeiling & Animation & Testing

P@j certainty

Counterexample found (
Alloy

Model Checking

VdmHolTranslator

translate model
venﬂcauan

generate proof commands for POs
- I ask HOL to discharge proof
oK Done

Calculation

Try simplified proof
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Proof Successful

Abstract Model

VDM
| Modetng  Animato  Tstng PO discharged!
Proof obligation

Counterexample found

Alloy
Medel Checking
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HOL

Verification

Proof failed
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Try simplified proof
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Proof Unsuccessful

| Modling & Animation & Testing

Proof obligation

Counterexample found (
Alloy

Model Checking

Assertion might be valid

Dune

Verification

Proof failed

Done
Calculation

Try simplified proof

is PO invalid?
is PO too complex?
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Proof Successful

Abstract Model
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Verification —
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PO Decomposition

Mode//mg & Animation & Testing

Proof obligation

Counterexample found
Alloy

Model Checking

Assertion might be valid

Dune

Proof failed

Calculation

Dune

Try simplified proof

decompose complex PO with
PF-transform

re-feed HOL with sub-proofs
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® \erification Life Cycle

* Process Analysis
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Integrity Checker
VDMTools generates POs (but doesn’t discharge them)

Automatic Proof Support

Generates HOL from a VDM++ model + POs (developed by
Sander Vermolen):

» supports a subset of the VDM++ syntax
« specialized proof tactics that can discharge proofs in HOL
« still under development



Verification Life Cycle
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VDM-HOL-Alloy strategy

Problem

Abstract Model

Mode/lmg & Animation & Testing J

Proof obligation
’ Done
/ Verification

Proof failed

Counterexample found Alloy
Model Checking

Assertion might be valid

Calculation

Try simplified proof

M.A. Ferreira, S.S. Silva, J.N. Oliveira

first go for proofs in HOL

then model check (if
needed)

NB: as earlier on, Alloy

models have to be written
by hand

Verifying Intel Flash File System Core Specification
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® File System Model
+ Example: FileStore
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FileStore = map Path to File
inv fileStore ==
forall path in set dom fileStore &
let parent = dirName(path) in
isElemFileStore (parent, fileStore) and
isDirectory(fileStore (parent));
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Hol_datatype ‘System
= <| table :((num, OpenFileDescriptor) fmap);
fileStore: ((Path, File) fmap) [>¢;

Define ‘inv_FileStore (inv_FileStore_subj:((Path, File) fmap
)) =
(let fileStore = inv_FileStore_subj in
('uni_1_var_1.
(((Cuni_1_var_1 IN (FDOM fileStore) ) /\
(? path.(path = uni_1_var_1 )) ) /\ T ) ==>
(let path = uni_1_var_1 in
(((dirName path) IN (FDOM fileStore) ) /\
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sig FileStore {
map: Path -> File
}

pred FileStoreInvariantVDM[fs: FileStorel{
RelCalc/Simple [fs.map, Filel and
RelCalc/Injective [fs.map, Pathl and
PathInvariantVDM[RelCalc/dom[fs.map]] and
FileInvariantVDM[RelCalc/rng[fs.mapl] and
FileStorelInvariant [fs]
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pred FileStorelInvariant[fs: FileStorel{
all path: RelCalc/dom[fs.map] {
isElemFileStore [path.dirName,fs] and
isDirectory [fs.map[path.dirName]]
}
}
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® File System Model

+ Example: FS_DeleteFileDir_FileStore
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private
FS_DeleteFileDir_FileStore: FileStore * set of Path ->
FileStore

FS_DeleteFileDir_FileStore(fileStore, paths) ==
paths <-: fileStore
pre forall path in set dom fileStore &
dirName (path) in set paths => path in set paths;
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® File System Model

* |Invariant Preservation PO
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» Is the FileStore Invariant still valid after excuting
FS_DeleteFileDir_FileStore?

forall fileStore : FileStore, paths : set of Path &
(forall path in set dom (fileStore) &
dirName (path) in set paths => path in set paths)
=> inv_FileStore(paths <-: fileStore)
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e Let’'s Model Check this PO

all fs,fs’: FileStore, paths: set Path {
FileStoreInvariantVDM[£fs] and
PathInvariantVDM[paths] => (
(all path : RelCalc/dom[fs.map] |
path.dirName in paths => path in paths) and
fs’.map = fs.map - (paths -> paths.(fs.map))
=> FileStoreInvariantVDM[fs’]
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As a matter of fact . ..
« HOL fails to discharge this PO

« Alloy doesn’t find any counter-examples
» PF-transformed pen-and-paper proof required

» PF-transform removes variables and quantifiers from
predicates — everything becomes a relation
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PF-transform blends particularly well with Alloy:
« Alloy is a relational language :-)
¢ Recall invariant PW definition:

pred FileStorelnvariant[fs: FileStorel{
all path: RelCalc/dom[fs.map] {
isElemFileStore [path.dirName,fs] and
isDirectory [fs.map[path.dirName]]
}
I
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o PF version of the invariant is much shorter — in Alloy
reads as follows:

pred FileStorelInvariant[fs: FileStorel{
(fs.map) . (File->Directory)
in (dirName).(fs.map).attributes.fileType
¥
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Using the relational calculus, one easily calculates WP for
FileStore invariant to be maintained — details in [Oli08]:

pred pre_FS_DeleteFileDir_FileStorePF[fs:FileStore,paths:set
Path] {
(((Path - paths)->Path) & iden).(fs.map)
in dirName.((Path - paths)->File)
}
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pred pre_FS_DeleteFileDir_FileStorePW[fs:FileStore,paths:set
Path] {
all path: RelCalc/dom[fs.map]l {
path.dirName in paths => path in paths
}
+
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assert pw_equiv_pf {
all fs: FileStore, paths: set Path {
pre_FS_DeleteFileDir_FileStorePW[fs,paths] <=>
pre_FS_DeleteFileDir_FileStorePF [fs,paths]
}
}
check pw_equiv_pf for 20
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FS_DeleteFileDir_FileStore: FileStore * set of Path ->
FileStore
FS_DeleteFileDir_FileStore(fileStore, paths) ==
paths <-: fileStore
pre forall path in set dom fileStore &
dirName (path) in set paths => path in set paths;
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® Conclusions
+ Tool Interoperability
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working with three different technologies is harder but
worthwhile

learning a lot on verification tool interoperability

different tools show different aspects of the problem

VDM-Alloy-HOL complement each other
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The only automatic step of the Verification Process:

Automatic Proof Support
o still "semi" automatic

« on-going work towards increasing automation

Also researching on
» how to use HOL for Weakest Pre-Condition calculation
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Automatic bidirectional conversion would bring great benefit:
» need to keep models consistent

e need for uniform rules across translations

« Alloy more abstract (declarative) than VDM
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Verifying complex models in more than one tool calls for code
slicing:
» one PO at a time ("single PO, multiple tool")

» need to isolate the smallest model which accommodates
given PO in each tool / notation (slice)
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® Conclusions

* Closing
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Translations

HOL Translator

Very useful for verification

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Translations

VDM HOL Translator

Already automated by the
VdmHolTranslator

oy HOL Translator

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Translations

DM HOL Translator

would allow for direct
model checking in Alloy

will remove the need to
synchronize separate
VDM-++ and Alloy models

oy HOL Translator

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Translations

VDM HOL Translator

Alloy-HOL inter-operation
interesting on its own

VDM Alloy Translator

increase the level of
confidence in all models

alloy !

M.A. Ferreira, S.S. Silva, J.N. Oliveira Verifying Intel Flash File System Core Specification
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Thank you for your attention

Work has just started
« everyone interested in the approach is welcome on board!
e http://twiki.di.uminho.pt/twiki/bin/view/Research/VFS/
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Deep Space lost contact
with Spirit on 21 Jan 2004,

Jjust 17 days after landing.
Wny formal methods?
Initially thought to be due to -l y Software bugs cost millions of dolars.

thunderstorm over Australia. b iﬁk

What we can do?

Spirit transmited an empty message and Build abstract models (VDM).

missed another communication session. Gain confidence on models (Alloy).
Proof correctness (HOL & PF-Transform).

After two days controllers were surprised

to receive a relay of data from Spirit.

Spirit didn't perform any scientific
activities for 10 days.

This was the most serius anomaly
in four-year mission.

Fault caused by Spirit’s
FLASH memory subsystem

M.A. Ferreira, S.S. Silva, J.N. Oliveira
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A mini challenge: build a verifiable filesystem.

J.N. Oliveira.
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Samuel Silva et al.
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